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Menu Bar Options

The Menu bar contains the following menus. 

File menu 
Edit menu 
Addresses menu 
Window menu 
Message menu 
Folder menu 
Reader menu 
Addressbook menu 

The File, Edit, Addresses, Window, and Help menus are always available. 

The Message menu appears on the Menu bar only when you are composing a message (that is, when the 
Message Editor window is the current window). 

The Folder menu appears on the Menu bar only when a folder window is the current window.

The Reader menu appears on the Menu bar only when your are reading a message (that is, when the 
message reader window is the current window).

The Addressbook menu appears on the Menu bar only when an address book window is the current 
window.



The File Menu

The File menu contains the following options:

New message:    Select this option to compose and send a new message.

Open saved message:    Select this option to open a draft of a message that you previously saved.

Read new mail:    Select this option to display the New Mail folder and read your mail.

Mail folders:    Select this option to browse through your mail folders, so that you can read and 
process your messages. 

Print:    Select this option to print a message or setup the printer configuration. The Print window 
appears. 

Preferences:    Select this option to customize the way FirstMail operates.

Exit:    Select this option to exit FirstMail.



Printing Messages and Reconfiguring the Printer

You can print messages when you are in a message reader window or folder window. You can reconfigure
the printer at any time.

To print the current message in the message reader window, click the Print button. The Print dialog box 
appears. Click the OK button to print the message.

To print one or more messages in a folder window, highlight the message(s) you want to print and select 
the Print option from the File menu. The Print dialog box appears. Click the OK button to print the 
highlighted messages.

To reconfigure the printer at any time, select the Print option from the File menu. The Print dialog box 
appears. Click the Setup button to display the printer window.

NOTE:    The Print dialog box always displays the last settings you used. FirstMail retains print settings 
until you change them. 

The Print dialog box contains the following fields and command buttons:

Printer:    The name of the currently selected printer (or the default Windows printer if this is the 
first time you are printing a message). You can select other installed printers by clicking the down 
arrow.

Margin:    Specify a printing margin for the Top/Bottom and Left/Right of the page. The default is 
20mm (one inch = 25.4mm) all round. FirstMail will not permit you to set margins narrower than 
10mm. 

Font:    Click this button to select a font that is supported by your printer.

OK:    Click this button to print the current message in the message reader window or the highlighted
message(s) in the folder window.

Cancel:    Cancel operation and close the Print dialog box.

Setup:    Click this button to display the standard MS-Windows printer setup dialog box, which 
varies from printer to printer. This dialog box enables you to change the printer configuration. For 
more information about any of the printer settings, click the Help button on the printer setup dialog 
box.



The Edit Menu

The Edit menu contains the following options for editing your messages:

Undo:    Select this option to undo the last operation.

Cut:    Select this option to cut highlighted text. The text is placed on the clipboard.

Copy:    Select this option to copy highlighted text. The text is placed on the clipboard. You can use 
this option to copy lines from a message you are reading and then paste the lines elsewhere (such as 
in a message you are writing). By pressing the Ctrl key while selecting lines you can select separate 
groups of lines simultaneously in the message, and copy them all with one command.

Paste:    Select this option to paste text (that you copied or cut) from the clipboard to the place where
your cursor is located. 

Clear:    Select this option to clear all text from the clipboard.

Select all:    Select this option to highlight all text.

Glossary:    Select this option to display the Glossary submenu, where you can select the Create/edit 
option to create a Glossary entry or the Expand option to expand the abbreviations in the text of your
message. For more information, see Saving Abbreviations in a Glossary and Expanding Them in 
Messages.



The Addresses Menu

The Addresses menu contains the following options:

Address books:    You can use the personal address book feature to help you address your messages. 
Select this option to display the "Select an address book" window. In this window you can open 
address books to address your messages, create new address books, modify existing ones, and delete 
ones you no longer need. (Note: You must create a persional address book and create entries in it 
before you can use it to address messages.)

Distribution lists:    You can use distribution lists when addressing messages to groups. Select this 
option to display the "Select a distribution list" window. In this window, you can address your 
messages to distribution lists, create new distribution lists, modify existing ones, and delete ones you
no longer need. (Note: You must create a distribution list before you can address messages to it.) 

Global Address Book:    You can use the Global Address Book feature to help you address 
messages. Select this option to display the "Global Address Book" window. In this window you can 
look up addresses of MHS users and groups. FirstMail automaatically creates the Global Address 
Book and it is always available.



Using Address Books

You can use the Address Books feature to address messages. To open an address book, click the address 
book button on the Button Panel, or select the Address book option on the Addresses menu. The "Select 
an address book" window appears. This window contains a list of the available address books. Either 
highlight the one you want and click the Open button, or double-click the address book. The address book
window appears.

To look up an address, you can either scroll through the list of entries in the address book window, or you 
can search the address book the list for entries that match a specific search string.

To add the address to a text field, you can use any of the following methods:

Highlight the address, drag it from the list, and drop it in any text field (it is also possible to drag 
addresses from FirstMail to edit controls in other applications, such as the MS-Windows Notepad 
program).

Highlight the address and press the Paste button (in the window) to add it to the text field where your
cursor was last.

Double-click the address to add it to the text field where your cursor was last.

Depending on the way you sorted the address book entries (using the sort option in the Addressbook 
menu), FirstMail will paste either the alias (the default) or the actual E-mail address into the destination 
field.

NOTE:    Most address fields in FirstMail can only accept at most 180 characters. If you select addresses 
with more characters than will fit in the field, FirstMail issues a warning. When this happens, consider 
creating a distribution list.

SUGGESTION: An easy way to start a new message is by double-clicking an entry in the address book. 
The entry you select is placed in the To header of the new message.



Using Distribution Lists

Most address fields in FirstMail can only accept at most 180 characters. If you select addresses with more
characters than will fit in the field, FirstMail issues a warning. When this happens, consider creating a 
distribution list.

To address a message to the members of a distribution list, either click the Distrib list button on the 
Button Panel, or select the Distribution list option on the Addresses menu. The "Select a distribution list" 
window appears, which contains a list of available distribution lists.

To add a distribution list to a text field (such as the To field in the Message Editor window) you can either
type the name of the distribution list in the field, or you can place your cursor in that field, move the 
cursor to the "Select a distribution list" window, and then either:

Double-click the distribution list

Highlight it and press the Select button to add it to the text field where your cursor was last



Using the Global Address Book

You can use the Global Address Book feature to address messages. The Global Address Book provides an
up-to-date list of all users and groups in the MHS database. The Global Address Book looks and works 
exactly like a read-only address book (that is, you can select addresses from it exactly like you do from 
one of your own address books but you cannot change any of the entries).

To open the "Global Address Book" window, select the Global Address Book option on the Addresses 
Menu. 

To search for a name, you can either scroll through the list or you can speed search by typing the first few 
characters of the name you want to find. When you highlight a name, additional information about the 
entry appears at the bottom of the window.

To address a message, you can use any of the following methods:

Highlight the name, drag it from the list, and drop it in any text field

Highlight the name and press the Paste button (in the window) to add it to the text field where your 
cursor was last

Double-click the name to add it to the text field where your cursor was last

IMPORTANT:    You should close this window after using it, because updates made to the MHS 
directory are not displayed until you reopen the window.

NOTE:    An easy way to start a new message is by double-clicking an entry in the "Global Address 
Book" window. The entry you select is placed in the To header of the new message.

See also:

Using Address Books



The Window Menu

From the Window menu you can arrange open windows and icons in the FirstMail window, open the 
Button Panel, and change which window is the active window. The Window menu contains the following 
options:

Tile:    Select this option to rearrange the open windows in the FirstMail window. FirstMail places 
the windows side-by-side.

Cascade:    Select this option to rearrange the open windows in the FirstMail frame window. 
FirstMail overlays (cascades) the windows starting from the top left corner to the bottom right corner
of the FirstMail frame window, with the active window placed at the bottom.

Arrange icons:    Select this option to rearrange all icons in the FirstMail frame window. FirstMail 
places the icons side-by-side at the bottom of the FirstMail frame window.

Button Panel:    Select this option to display the Button Panel in the FirstMail window.

The Window menu also lists the open windows and icons that are displayed in the FirstMail window. A 
check mark indicates which window is active. You can change the active window by selecting a different 
window on this menu. The check mark will move to the window you select.



The Message Menu

When you are composing a message, the Message menu appears on the Menu bar. The Message menu 
contains the following options:

Save message:    Select this option to save a draft of a message you are writing. After you save the 
draft, you can return to it later and finish it.

Import into message:    Select this option to import a text file into the message you are composing.

Save window size:    Select this option to save the size of the Message Editor window (if you resized
it and want to retain the current size for future messages).

Attachments:    When you are in the Editor or Special Options page of the Message Editor window, 
select this option to display the Attachments page of the Message Editor window. The Attachments 
page lists the attachments associated with the message you are composing. You can also add and 
delete attachments. Selecting this option is the same as clicking the Attach button in the Message 
Editor window.

Message editor:    When you are in the Attachment or Special Options page of the Message Editor 
window, select this option to return to the Editor page of the Message Editor window. The Editor 
page contains the editing field where you can compose or edit your message. Selecting this option is 
the same as clicking the Editor button in the Message Editor window.

Special options:    Select this option to display the Special Options page of the Message Editor 
window, when you are in the Editor or Attachments page. The Special Options page contains special 
delivery options you can set for the message you are composing. Selecting this option is the same as 
clicking the Special button in the Message Editor window.

Font:    Select this option to display the Font dialog box. You can choose a new display font for the 
Message Editor window. FirstMail retains your font selection for all future messages and will 
immediately apply it to all open message windows. A message can only use one font.



Special Options

To set delivery options for the message you are composing either select the Special options option on the 
Message menu, or click the Special button in the Message Editor window. The Special Options page of 
the Message Editor window replaces the Editor page. The Special Options page contains the following 
delivery options that you can set for your message:

Blind CC:    Enter the address of any recipient to whom you want to send a Blind Carbon Copy 
(Blind CC) of your message. The address(es) are added to the BCC header of your message.

Send replies to:    If you want replies to your message sent to an address other than your own, enter 
an address in this field. This is useful if you want replies sent to an assistant or a coworker. If you do 
not specify an address in this field, replies will to sent to your address.

Message is obsolete after:    If your message is only meaningful for a certain length of time, enter 
the time after which it is obsolete. After that date, the message listing will appeared grayed out in the
recipient's list of messages.

Message width:    The average length of a line of text in your message. FirstMail will adjust the 
margin of the message editor so that approximately the number of characters you specify will fit on a
line. You cannot enter a width wider than the current width of the editing window. Select the "Set as 
default" check box if you want to use the value you enter for all future messages.

Average <Tab> width:    By default, FirstMail obeys the standard Windows convention that the 
<Tab> key moves from field to field in a dialog box. However, if you enter a width in this field, 
FirstMail will insert the <Tab> characters in the message instead. You can only change the tab width 
if tabs were enabled when you started the message. You can enable tabbing for all future messages 
by selecting the "Set as default" check box. The width you enter is an average based on the average 
width of characters in the current font; it will only be exact if you use a monospace font such as 
Courier.



Saving a Draft of a Message and Opening It Later

You can save your message in a draft format and open it later to continue composing or editing it. 

To save a draft of the message you are writing, select the Save message option from the Message menu. 
The "Save message as draft" dialog box appears. It contains a default title (which is generated by 
combining the address and subject of your message). You can change the title by typing another name in 
the Description field. If you do not want the draft file deleted the next time you reopen the draft, select the
"Save as mail stationery" check box. (You can use this feature to create a template for future messages, so
you can use them repeatedly.) Click the OK button to save the draft. 

To reopen a draft message (at any time), select the Open saved message option on the File menu. You can 
continue editing your message.

NOTE:    When you reopen a draft, the draft file is deleted, unless you selected the "Save as mail 
stationery" check box before you saved the draft. The only way to delete a stationery draft is to select the 
Open saved message option from the File menu, highlight the draft you want to delete, and click the 
Delete button.

See also:

Message menu
File menu



The Folder Menu

When you are browsing through messages in a folder window (that is, when a folder window is the 
current window), the Folder menu appears on the Menu bar. The Folder menu contains the following 
options:

Find:    Select this option to search the contents of the current folder for a text string. The "Find text 
in folder" dialog box appears. In the "Search for" field, type the text you want to find. The text can 
contain the DOS wildcard characters (* and ?). The "Find text in folder" dialog box also contains the
following check boxes:

Search message headers only:  Check this box if you want to restrict the search to the message 
headers. FirstMail opens the first message containing text that matches your search string. If you 
only want to search for a particular header, enter the search text in the following format: 
<header_name>:<search_string>. For example, From:*acme*

Mark all matching messages:  Check this box if you want to highlight    (but not open) all 
messages in the folder with text that matches the text you specified. This option is handy if you 
want to tag all messages on the same subject for moving or copying.

Find again:    Select this option to repeat the last search (using the same search string).

Sort by date, reverse date, subject, or sender:    Select one of these options to sort the messages in 
the current folder. You can sort by date (the newest message at the bottom or the top of the list) or 
alphabetically (based on the text in the Subject header or the sender's name). The default for folders 
is Sort by date. A check mark indicates how the folder is currently sorted. FirstMail retains the last 
sorting option you selected between sessions.

Special:    Decode a message you received.

Font:    Select this option to set the font that FirstMail uses to display the list of messages in the 
Folder window. This setting is global to all folders and is retained between sessions. The change 
takes place immediately. If you choose a large font, some of the displayed information will be 
truncated. 



Encoding and Decoding Messages

Encoding

When you send an attachment, it cannot always be transmitted as-is. Sometimes it is necessary to package
the attachment in a particular way so that the mail transport system or the recipient's mailer can 
understand it. You need to change the attachment encoding only in very special cases. FirstMail supports 
the following attachment encodings:

FirstMail decides:    (Default) Select this option to allow FirstMail to choose the encoding.

No encoding:    Select this option to prevent FirstMail from encoding the message. This option 
should be used only for local deliveries between FirstMail users with mailboxes on the same server. 

ASCII text:    Select this option to indicate that the attachment contains only valid ASCII text with 
<CR/LF> line endings. Use this encoding only when you are sending documents created with the 
DOS EDIT command or any other text editor. Do not use this encoding for documents created with a
word processor.

UUencoding:    Select this option to send messages over the Internet and to UNIX environments. 

BinHex:    Select this option if the recipient uses a Macintosh computer and the recipient's E-mail 
application supports the BinHex format.

Decoding

Sometimes FirstMail will be unable to recognize that a message is actually an attachment sent using a 
special encoding method called UUencoding or BinHex. If you receive such a message, highlight it in the 
folder window and select the Special option on the Folder menu. Then select either of the following 
option, as appropriate:

UUdecode message: Select this option if the message was sent across the Internet by someone using
a mail system other than FirstMail. When you select this option, FirstMail will prompt you for a 
filename and will attempt to decode the message for you.

Un-BinHex message: Select this option if the message was sent from a Macintosh computer. 
BinHex is another special transmission format like UUencoding, commonly used on Apple 
Macintoshes. When you select this option, FirstMail will prompt you for a filename and will attempt 
to decode the message for you. 

NOTE:    BinHexed files from Macintosh users may be useless to you on a PC. Some programs such as 
WordPerfect and MS-Excel create data files that are compatible with both platforms.



The Reader Menu

When you are reading a message (that is, when a message reader window is the current window), the 
Reader menu appears on the Menu bar. The Reader menu contains the following options:

Save window size:    Select this option to save the current size of the message reader window (if you 
want to retain the current size for future messages).

Show all headers:    Select this option to display the current message exactly as it was delivered, 
with its headers intact. By default, FirstMail displays only the message headers that are meaningful 
to the reader, and suppresses all others. 

Extract message to file:    Select this option    to copy the current message in a DOS text file. The 
"Save as" dialog box appears. You can navigate using the File and Directory lists, or type the 
filename in the Filename field. When you are done, click the OK button. FirstMail extracts the 
contents of the message to the file.

Font:    Select this option to change the font you use to view messages in a message reader window. 
This change is global, and affects all open and subsequently opened messages. FirstMail retains this 
setting until you change it.



The Addressbook Menu

When an address book window is the current window, the Addressbook menu appears on the Menu bar. 
The Addressbook menu contains the following options:

Find:    Select this option to search an address book for a text string. The "Search address book for" 
dialog box appears. In the "Search for" field, type the text you want to find. Select the "Check all 
matching entries" check box if you want FirstMail to highlight all matching entries instead of 
stopping at the first match.

Find again:    Select this option to repeat the last search, using the same search criteria.

Sort by key or name:    Select this option to sort address book entries by the key you associated with
the entry or by the entry name. Each address book retains the specified sort order between sessions. 
A check mark indicates the current sort order.

Paste names or addresses:    Select this option to indicate whether FirstMail should paste the name 
(that is, the alias) or the address of the recipient in an address field the next time you use an address 
book to add an address to a message. FirstMail retains this setting until you change it. The default is 
Paste names.

Resolve aliases:    Select this option to if you want FirstMail to associate an address with each name 
(alias) specified in an address field when you send a message. Alias resolution can take a long time if
you have many or large address books, so you may want to disable it for some or all of your books. 
By default FirstMail resolves aliases in all address books.



Displaying and Using the Button Panel

The Button Panel is a small floating window that gives you quick access to the most commonly used 
features. The Button Panel contains the following buttons:

Send mail:    Click this button to open the Message Editor window where you can compose a new 
message.

Read new mail:    Click this button to open the New Mail folder where you can read and process 
your new mail.

Mail folders:    Click this button to open the "Select a folder" window where you can open or work 
with other mail folders and read or process previously-read mail.

Address books:    Click this button to open the "Select an address book" window where you can 
open or work with address books.

Distrib lists:    Click this button to open the "Select a distribution list" window where you can work 
with distribution lists.

To display the Button Panel, select the Button Panel option on the Window menu. The Button Panel 
window appears, which you can move anywhere on the FirstMail frame window. The buttons are 
displayed horizontally. If you want to change the display to vertical, select the Preferences option on the 
File menu, and then select the General settings option. Select the "Vertical button panel (when open)" 
check box, and then click the OK button.

FirstMail retains the Button Panel's location and state (open or closed) between sessions. 



Composing and Sending Messages

Messages are divided into two parts: headers (informational lines at the start of the message, such as To, 
Subject and CC), and the message body (the text of the message).

To compose a message, click the Send mail button on the Button Panel or select the New message option 
on the File menu. The Message Editor window appears. It contains the following fields and command 
buttons. It also contains a set of check boxes for specifying delivery options.

Fields:

To:    (Required) Specify the address of each primary recipient. 

Subject:    (Optional) Specify a summary (up to 64 characters long) of your message. Because the 
recipient can use the subject line as a filing key, you should try to make it as descriptive as possible. 

CC:    (Optional) Specify the address of each Carbon Copy recipient to whom you want to send a 
copy.

Message-body:    ( Optional) Enter your message in this field. The text wraps when it reaches the 
right margin, or you can press <Enter> to end a line. You can use the Edit menu options to cut and 
paste text and you can store abbreviations for commonly-used text in the glossary.

Command Buttons:

Editor:    Click this button to return to the Editor page from the Attachments or Special Options page
of the Message Editor window.

Attach:    Click this button to display the Attachments page of the Message Editor window. When 
you display this page you can attach files (attachments) to your message.

Special:    Click this button to display the Special Options page of the Message Editor window. 
When you display this page, you can select special delivery options for your message.

Send:    Click this button to send your message.

Cancel:    Click this button to cancel the operation and close the Message Editor window.

NOTE:    When you open the Message Editor window, the Message menu appears on the Menu bar. 

See also:

Addressing messages 
Importing text from other sources 
Setting delivery options 
Saving a draft of a message 
Message menu 



Addressing Messages

Just as the postal service needs an address to be able to deliver a letter, FirstMail requires an address to be
able to send your electronic mail. You can enter the E-mail address of any individual or distribution lists 
into any address field, including the To, CC, and Blind CC fields. 

If you know a recipient's address, you can add it to a message by typing it in an address field. The easy 
way to look up addresses and add them to your message is by selecting the Addresses menu on the Menu 
bar, and then selecting one of the following options:

Address books
Distribution lists
Global Address Book

(You can also access Address Books and distribution lists by clicking the appropriate button on the Button
Panel.)

NOTE:    Before an address book can appear in the "Select an address book" window, you must create the
address book. Before a distribution list can appear in the "Select a distribution list" window, you must 
create the distribution list.



Importing Text from Other Sources

You can add text from other applications to your message in the following ways:

Cut and paste:    You can use the standard cut, copy and paste commands on the Edit menu to move 
text around within Windows.

Import a plain text file into the body of your message:    To import a file into your message, select 
the Import into message option on the Message menu. The "Select a file" dialog box appears. You 
can either type the filename (including a full path) in the Filename field, or you can navigate using 
File and Directory lists. The Files list shows the files in the current directory and the Directories list 
shows the directories available on the current drive and other available drives. Double-click a drive 
or directory in the Directories list to select it. When you select a drive (or directory), a list of all the 
directories and files that are on the selected drive (or in the selected directory) appears in the Files 
list. To import the contents of a file, either highlight the file and press the Open button, or double-
click the file in the list .

NOTE:    The file you import must be a text file created with the DOS EDIT command or a text editor, 
(Word processor files are usually not text files.) The file can contain up to 32000 characters.



Including Attached Files (Attachments) with Messages

You can attach up to 64 files to any message you send. 

To attach files to your mail message, click the Attach button in the Message Editor window. The 
Attachment page of that window replaces the Editor page. The Attachment page lists the current 
attachments (if any) and contains the following fields for specifying files: 

Name of the file:    (Required) You can specify a file by either typing the filename (including an 
optional DOS path) in the Filename field, or by selecting the file from the two file lists in the lower 
half of the window. The Files list shows the files in the current directory and the Directories list 
shows the directories available on the current drive and other available drives. Double-clicking an 
item in the Directories list selects that drive or directory and fills the Files list with the files it 
contains. Double clicking a file in the Files list automatically adds it to the list of attachments for the 
message. FirstMail will add the file to the attachment list with the current settings of the File type 
and Attachment encoding fields.

Type of file:    (Optional) Provide information about the file for the recipient. To select a file type 
from the list, click in the file-type box. If you are uncertain of the type of file, you should use 
Unknown, the default choice.

Encoding to be used for transmission:    (Optional) Preserve all the information about the file in a 
meaningful way which will be understood by the recipient's mail program. Select the file encoding 
from the types in the Encoding list (your choice depends on how and where the message is being 
sent).

NOTE:    Before you select files to attach, select the File type and attachment encoding. You cannot 
change the settings for an attachment once you have added it to the list. You must remove it and re-add it 
instead.

When you are finished specifying the file, click the Add button to add the file to the attachment list. When
you are finished adding files, click the Done button to return to the Editor page and resume composing 
your message. 

NOTE:    You can re-edit your attachment list at any time prior to sending the message by clicking the 
Attach button. To remove an attachment from the list, highlight it and click the Remove button. 
Removing an attachment from the list does not affect the original file. 



Setting Delivery Options

The Message Editor window contains the following set of check boxes that control delivery options:

Confirm reading:    Select this check box to request confirmation when a recipient opens a message 
that you sent. If the recipient's E-mail application supports this feature, you will receive a 
notification message when the recipient opens the message. FirstMail retains this setting until you 
change it.

Confirm delivery:    Select this check box to request confirmation when a message has been 
delivered to the recipient's mailbox. If the recipient's messaging application supports this feature, 
you will receive a notification message when the message you sent arrives at the recipient's mailbox.
FirstMail retains this setting until you change it.

Copy self:    Select this check box to request that a copy of your message be placed in your "Copies 
to self" folder when you send the message. If this folder does not exist, FirstMail creates it. If this 
folder becomes too full, you can force FirstMail to create a new one by renaming the existing one. 
(You must change the filename as well as the long name when doing this.) FirstMail retains this 
setting until you change it.

Urgent:    Select this check box to indicate that your message is important. If the recipient's E-mail 
application supports this feature, the message is listed at the top of the recipient's New mail folder. If 
the recipient has a color monitor, the message listing is displayed in red. Otherwise, the listing is 
highlighted.

No signature:    Select this check box to prevent your pre-configured signature from being added to 
the end of the message. 

In addition, clicking the Special button in the Message Editor window provides specialized delivery 
options. 

See also:

Creating a Signature



Saving Abbreviations in a Glossary and Expanding Them in Messages

You can create and store abbreviations for commonly-used text strings that you want to use in messages. 
After you type the abbreviation into a message, you can expand the abbreviation to display the full text. 
This can be an extremely fast way of preparing form letters using "boilerplate" text and can save a 
considerable amount of typing if you repeatedly send similar messages. 

To create a glossary entry, do the following:

1.  Select the Glossary option on the Edit menu and then select the Create/Edit option. The Glossary 
dialog box appears. It contains an Abbreviations field, a Full Text field, and the following command 
buttons:

Add:    Create a new abbreviation
Delete:    Delete the abbreviation selected in the Abbreviation field
Copy:    Copy any highlighted text in the Full text field to the clipboard
Paste:    Paste any text in the clipboard to the Full text field
Save:    Save the changes you have made to the glossary
Cancel:    Abandon the operation and close the Glossary dialog box

2.  Click the Add button. The Abbreviation dialog box appears.

3.  Enter a short abbreviation representing the full text. Abbreviations cannot contain spaces. 

4. Click the OK button to return to the Glossary dialog box. Your abbreviation is highlighted in the 
Abbreviation field and your cursor is in the Full text field. 

5.  Type the full text that you want to associate with the abbreviation.

6. Click the Save button. You have now associated the full text with the abbreviation. 

You can change an abbreviation or the associated full text at any time by highlighting and then editing it.

To use a glossary entry in your message, type the abbreviation in place of the full text. With the text 
insertion mark at the end of the abbreviation, select the Glossary option on the Edit menu, and then select 
the Expand option. FirstMail replaces the abbreviation in the message with the full text you defined.

NOTE: You can embed a text file in a glossary entry by embedding a special string of characters in the 
glossary entry. The string must begin with a tilde followed immediately by a question mark (~?), followed
without spaces by the full pathname of the file. After the filename, place a single tilde (~) character to 
mark the end of the string. For example:

~?C:\SALES\MAY_RPT.TXT~



Reading and Processing Messages

FirstMail stores your messages in folders. FirstMail creates the New mail folder (where unread messages 
are stored) and Main folder (where previously-read messages are stored) when you start FirstMail for the 
first time. You can create other mail folders as you need them.

To read new messages, click the Read new mail button on the Button Panel or select the Read new mail 
option on the File menu. The "New mail" window appears.

To read messages you saved, click the Mail folders button on the Button Panel or select the Mail folders 
option on the File menu. The "Select a folder" window appears. This window contains a list of available 
folders. The pair of numbers to the right of each folder in the list represent the total number of messages 
in the folder and the number of unread messages in the folder respectively.

To select a folder, you can either highlight it and click the Open button, or double click it. A window 
appears for the folder you selected. The folder's window lists the messages that are in the folder. Each 
entry in the list contains the sender's name, the subject of the message and the date the message was sent. 
Messages with attachments are preceded by a dot. Previously-opened messages are preceded by a check 
mark. The folder's window also contains the following set of command buttons, which will work on 
single or multiple messages:

Open:    Click this button to open the highlighted message so that you can read it. (You can also open
a message by double-clicking it in the list). The message reader window appears containing the 
message.

Reply:    Click this button to send a reply to all highlighted messages. The "Reply options" dialog 
box appears. If you select multiple messages, a "Reply options" dialog box appears for each selected 
message (in order). Specify the reply options and click the OK button. A new message editor 
window appears (for each reply). 

Forward:    Click this button to forward all highlighted messages to one or more third parties. The 
"Forward message to" dialog box appears, prompting you for an address.

Move:    Click this button to move one or more highlighted messages from the current folder into 
another folder. The "Select a folder" window appears. Double-click the folder into which you want 
to move the messages.

Copy:    Click this button to copy of one or more highlighted messages into another folder, without 
disturbing the original messages in the current folder. The "Select a folder" window appears. Double-
click the folder into which you want to copy the messages.

Delete:    Click this button to delete the highlighted message and any associated attachments. 

Info:    Click this button to display detailed information about one or more highlighted messages, one
at a time. The "Message Information" window appears, which contains information about the 
highlighted message.

NOTE:    When you are browsing through messages in a folder (that is, when the window for a specific 
folder is the current window), the Folder menu appears on the Menu bar. The Folder menu contains 
special options and functions for sorting folders.



See also:

Saving Attachments
Printing messages
Folder menu
Reader menu



Reading new and saved messages

To open a message (that is, to display the contents of a message), either highlight the message listed in the
folder window and click the Open button, or double click the listed message. The message reader window
appears. The message reader window contains the message's headers and body text. If also contains the 
following command buttons:

Reply:    Click this button to send a reply to the current message. 

Forward:    Click this button to forward the current message. 

Move:    Click this button to move the current message into another folder. 

Attachment:    Click this button to list and save each attachment to a file. 

Delete:    Click this button to delete the current message. Deleting the current message will load the 
next message from the folder into the message reader window.

Print:    Click this button to print the current message or reconfigure the printer.

Prev:    Click this button to replace the current message in the message reader window with the 
previous message listed in the folder window. 

Next:    Click this button to replace the current message in the reader window with the next message 
listed in the folder window. 

If you hold down the Shift key while you click either the Prev or the Next button, the message you are 
leaving will be marked in the folder window before the previous or next one is loaded into the message 
reader window. This is useful when you want to perform one type of operation on multiple messages 
(such as deleting or copying) when you are finished reading them.

NOTE:    When you are reading a message (that is, when the message reader window is the current 
window), the Reader menu appears on the Menu bar. The Reader menu contains options specific to the 
message reader window.



Saving Attachments

When you are in the message reader window, you can save attachments that are associated with the 
current message.

To save an attachment to a file, click the Attachment button. The "Message attachment" window appears, 
which lists the attachments associated with the current message. The list of attachments contains the 
filename for the attachment and the type of file if known. 

You can save an attachment to a disk file by highlighting it and clicking the Save button. 

When you save the attachment to a file, you can change the filename or accept the original name.

See also:

Reading New and Saved Messages



Replying to Messages
 
You can reply to messages when you are in either a folder window (browsing through messages) or a 
message reader window (reading a message).

To send a reply, do the following:

If you are in a folder window, highlight the message and click the Reply button.    

If you are in a message reader window, click the Reply button. 

The "Reply options" dialog box appears, which contains the following options:

Copy original CC field into reply:    Select this check box to copy the CC field of the original 
message into your reply.

Reply to all original addressees:    Select this check box to send your reply to everyone who 
received the original message. 

Include original message in reply:    Select this check box to load a copy of the original message 
into your reply. You can edit the included text. 

Comment-out included message:    Select this check box to place a right angle-bracket (>) character
at the start of each line of the included original message. 

NOTE:    When replying to a message, FirstMail automatically adds "Re:" to the beginning of the text in 
the original Subject header. 



Forwarding Messages

You can forward messages when you are in either a folder window (browsing through messages) or a 
message reader window (reading a message).

To forward messages (to one or more other messaging users, groups, occupational roles, and/or 
distribution lists), do the following:

If you are in a folder window, highlight one or more messages and click the Forward button.

If you are in a message reader window, click the Forward button.

The "Forward message to" dialog box appears, which prompts you for the address to which the message 
should be forwarded. 

If you select the Edit before forwarding check box, a message editor window appears where you can add 
text or edit the contents of the message before you send it. Otherwise, the message is forwarded directly.



Moving Messages to Another Folder

You can move messages to another folder when you are in either a folder window (browsing through 
messages) or a message reader window (reading a message). When you move a message, FirstMail moves
the original message to the folder you specify.

To move a message from the current folder to another folder, do the following:

If you are in the folder window, highlight one or more messages and click the Move button.

If you are in the message reader window, click the Move button.

The "Select a folder" window appears, listing the available folders. Double-click the folder where you 
want to move the message. (You can also create a new folder if you wish.)

NOTE:    If the message you are moving has not been read, the unread messages counter for the 
destination folder (displayed in the "Select a folder" window) increases by one.



Copying Messages to Another Folder

You can copy messages to another folder when you are in the folder window (while browsing through 
messages). When you copy a message, FirstMail places a copy of the original message in the folder you 
specify. The original message remains undisturbed.

To copy messages, highlight one or more messages and click the Copy button. The "Select a folder" 
window appears, listing the available folders. Double-click the folder where you want to place a copy. 
(You can also create a new folder.)

NOTE:    If the message you are copying has not been read, the unread messages counter for this folder 
(displayed in folder in the "Select a folder" window) will increase by one.

WARNING:    If you copy a message with attachments, and later delete the copy, FirstMail 
automatically deletes the attachments associated with the original message.



Deleting messages

You can delete messages when you are in either the folder window (while browsing through messages) or 
the message reader window (while reading a message).

To delete messages, do the following:

If you are in the folder window, highlight one or more messages and click the Delete button.

If you are in the message reader window, click the Delete button.

WARNING:    If you copy a message with attachments, and later delete the copy, FirstMail 
automatically deletes the attachments associated with the original message.

NOTE:    If you selected the Preserve deleted messages until exit check box in the General settings dialog
box, you can recover mail messages you delete accidentally. When you click the Delete button, FirstMail 
moves the deleted messages to the "Deleted messages" folder. (FirstMail will create this folder if it does 
not exist.) FirstMail does not delete the messages in this folder until you exit from FirstMail. Therefore, 
you can open the "Deleted messages" folder (prior to exiting FirstMail) and move or copy any messages 
you wish to recover.

IMPORTANT:    Do not select the Preserve deleted messages until exit check box if you are running in 
an environment with low or restricted disk space.



Working with Folders

A folder is a file in which messages are stored. The Main folder is the default mail file containing 
messages that you previously read. You can also create other folders to organize messages that you wish 
to keep.

NOTE:    The only "folder" that is not a mail file is the New Mail folder. The New Mail "folder" is 
actually a directory to which your new messages are delivered. 

To work with folders, click the Mail folders button on the Button Panel or select the Mail folders option 
on the File menu. The "Select a folder" window appears. 
This window contains a list of available folders. Next to each listed folder is a pair of numbers, 
representing the number of messages in the folder and the number of unread messages in the folder 
respectively. The "Select a folder window also contains the following command buttons:

Open:    Click this button to open the highlighted folder. (You can also open a folder by double 
clicking the folder in the list.) A folder window appears, containing a list of the messages in that 
folder. From the folder window you can read and process the messages. 

New:    Click this button to create a new folder.

Delete:    Click this button to delete the highlighted folder.

Rename:    Click this button to rename the highlighted folder.

Cancel:    Click this button to cancel the current operation and close the "Select a folder" window.

NOTE:    When you open a folder by selecting it from the list in the "Select a folder" window, the Folder 
menu appears on the Menu bar. 

See also:

Moving messages to another folder
Copying messages to another folder
Folder menu



Creating Folders

To create a folder, do the following:

1. Click the Mail folders button on the Button Panel or select the Mail folders option on the File menu.
The "Select a folder" window appears. 

2. Click on the New button to display the "Enter long name and file name" window.

3. Enter the folder's long name in the "Long name for item" field. This is the name displayed in the 
Select a folder window. The long name can contain up to 50 characters.

4. (Optional) Enter the filename in the Filename field. This is the name of the mail file containing the 
folder's contents. If you leave it blank, FirstMail generates a default name for the folder. If you 
provide a filename, you must ensure that the new filename contains only legal DOS characters and 
that the filename has no extension. Also ensure that the filename you specify does not already exist.

5. Click the OK button to save the folder and add the folder to the list of existing folders.



Deleting Folders

To delete a folder, do the following:

1. Click the Mail folders button on the Button Panel or select the Mail folders option on the File menu.
The "Select a folder" window appears. This window contains a list of available folders.

2. Highlight the folder you want to delete.

3. Click the Delete button. 

4. Click the Yes button when prompted for confirmation.



Renaming Folders

To rename a folder, do the following:

1. Click the Mail folders button on the Button Panel or select the Mail folders option on the File menu.
The "Select a folder" window appears. This window contains a list of existing folders.

2. Highlight the folder that you want to rename.

3. Click the Rename button to display the "Enter long name and file name" window.

4. Make the appropriate changes to the long name, the filename, or both. If you change the filename 
you must ensure that the new filename contains only legal DOS characters and that the filename has
no extension. Also ensure that the filename you specify does not already exist.

5. Click the OK button to save the changes.



Working with Distribution Lists

Distribution lists are groups of addresses to which you send mail frequently. Distribution lists provide an 
easy way to address messages. If you have lists of users to whom you send mail regularly, or you need to 
send a message to more addresses than will fit in an address field (FirstMail can accept up to 180 
characters in any address line), you can create a distribution list.

To work with distribution lists, click the Distrib list button on the Button Panel or select the Distribution 
list option on the Addresses menu. The "Select a distribution list" window appears. This window contains 
a list of available distribution lists and the following command buttons:

Select:    Click this button to add the highlighted distribution list to the text field where your cursor 
was last.

Edit:    Click this button to modify the highlighted distribution list (such as adding members, 
changing members' addresses, or changing the delivery options). 

New:    Click this button to create a new distribution list.

Rename:    Click this button to rename the highlighted distribution list.

Delete:    Click this button to delete the highlighted distribution list.

Cancel:    Click this button to cancel the current operation and close the "Select a distribution list" 
window.

See also:

Addressing Messages to Distribution Lists



Creating Distribution Lists

To create a distribution list, do the following:

1. Click the Distrib list button on the Button Panel or select the Distribution lists option on the 
Addresses menu to display the "Select a distribution list" window.

2. Click the New button. The "Enter long name and file name" dialog box appears.

3. Enter the distribution list's long name in the "Long name of item" field. This is the name displayed 
in the "Select a distribution list" dialog box. It can contain up to 50 characters.

4. (Optional) Enter the filename. This is the name of the file containing the distribution list's contents. 
If you leave it blank, FirstMail generates a default filename. If you provide a filename, you must 
ensure that the new filename contains only legal DOS characters and that the filename has no 
extension. Also ensure that the filename you specify does not already exist.

5. Click on the OK button to save the distribution list. FirstMail adds the new distribution list to the list
of existing distribution lists.

6. Highlight the new distribution list and click the Edit button. The Distribution list dialog box appears.
This dialog box contains the following fields and check boxes:

Title:    The name you specified as the long name in Step 3.

To:    (Optional) If you want the address of the distribution list to appear in the To header (when 
sending a message to a distribution list) instead of the address of each distribution-list member, 
type the distribution list's address in the To field. Doing this suppresses the enumeration of the 
recipients (distribution list members) in the To header of the message. Suppressing the 
enumeration of the list can be useful if the list is very large. Enter the distribution list's address in 
MHS address format.

Reply to:    (Optional) Enter an address (other than your own) where you want replies sent (such 
as a group moderator).

The four check boxes (Confirm reading, Confirm Delivery, Urgent, No signature):    Select 
any check boxes that are appropriate. These settings override the delivery options that you set in 
the Message Editor (while composing your message), but only for messages sent to this 
distribution list. 

7. Enter the addresses of the distribution list members in the "Addresses, one per line" field. You can 
type in the address, or highlight and drag the address from an address book or the Global Address 
Book window. Enter only one address per line. Blank lines in the list are ignored. 

See also:

Creating a Signature



Deleting Distribution Lists

To delete a distribution list, do the following:

1. Click the Distrib list button on the Button Panel or select the Distribution list option on the 
Addresses menu. The "Select a distribution list" window appears. This window contains a list of 
available distribution lists.

2. Highlight the distribution list you want to delete.

3. Click the Delete button. 

4. Click the Yes button when prompted for confirmation.



Modifying Distribution Lists

To modify a distribution list (such as adding members, changing members' addresses, or changing the 
delivery options), do the following:

1. Click the Distrib list button on the Button Panel or select the Distribution list option on the 
Addresses menu. The "Select a distribution list" window. This window contains a list of available 
distribution lists.

2. Highlight a distribution list and click the Edit button. The Distribution list dialog box appears.

3. Make the appropriate changes.

4. Click the Save button to save the changes.



Renaming Distribution Lists

To rename a distribution list (the long name, the filename, or both), do the following:

1. Click the Distrib list button on the Button Panel or select the Distribution list option on the 
Addresses menu. The "Select a distribution list" window appears. This window contains a list of 
existing distribution lists.

2. Highlight the distribution list that you want to rename.

3. Click the Rename button to display the "Enter long name and file name" window.

4. Make the appropriate changes. If you change the filename, you must ensure that the new filename 
contains only legal DOS characters and that the filename has no extension. Also ensure that the 
filename you specify does not already exist.

5. Click the OK button to save the changes.



Working with Address Books

You can store frequently used E-mail addresses (including addresses of individuals, NetWare groups, 
occupational roles, and distribution lists),and related information in address books. You can organize 
these addresses by creating as many address books as you wish.

To work with address books, click the Address books button on the Button Panel or select the Address 
books option on the Addresses menu. The "Select an address book" window appears. This window 
contains a list of existing address books and the following command buttons:

Open:    Click this button to open the highlighted address book. (You can also open an address book 
by double clicking it in the list.) The address book window appears. In this window you can create, 
modify, and delete address book entries.

New:    Click this button to create a new address book.

Delete:    Click this button to delete the highlighted address book.

Rename:    Click this button to rename the highlighted address book.

Cancel:    Click this button to cancel the current operation and close the "Select an address book" 
window.

When you open an address book, the address book window appears. This window lists the address-book 
entries by name and/or by alias. When you click an entry in the list, all the details about that entry appear 
in the information pane at the bottom of the address book window.

NOTE:    When you open an address book by selecting it from the list in the "Select an address book" 
window, the Addressbook menu appears on the Menu bar. 

See also:

Creating Address Book Entries
Deleting Address Book Entries
Modifying Information About Address Book Entries
Using Address Books to Address Messages
Searching Address Books



Creating Address Books

To create an address book, do the following:

1. Click the Address books button on the Button Panel or select the Address books option on the 
Addresses menu. The "Select an address book" window appears. This window contains a list of 
existing address books.

2. Click the New button to display the "Enter long name and file name" dialog box. 

3. Enter the long name of the address book in the "Long name for item" field. This name appears in the
address book list. The long name can contain a maximum of 50 characters, including spaces.

4. (Optional) Enter a filename in the Filename field. This is the name of the file containing the address 
book information. If you leave this field blank, FirstMail generates a default name. If you provide a 
filename, it can contain up to eight legal DOS characters with no extension. 

5. Click the OK button to save the address book. FirstMail adds the address book to the list of existing 
address books.

After you create an address book, you can create address book entries for recipients to whom you send 
messages.



Deleting Address Books

To delete an address book, do the following:

1. Click the Address books button on the Button Panel or select the Address books option on the 
Addresses menu. The "Select an address book" window appears. This window contains a list of 
existing address books.

2. Highlight the address book you want to delete.

3. Click the Delete button.

4. Click the Yes button when prompted for confirmation.



Creating Address Book Entries

To create an address book entry, to the following:

1. Click the Address books button on the Button Panel or select the Address books option on the 
Addresses menu. The "Select an address book" window appears. This window contains a list of 
existing address books.

2. Select the address book in which you want to create the entry, by either highlighting the address 
book and clicking the Open button, or by double-clicking the address book in the list. The address 
book window appears.

3. Click the Add button to display the "Edit address entry" window, which contains the following 
required fields (the rest are optional and are used for informational purposes only):

Name:    Name (alias) of the person associated with this entry. Once you have created an address 
book entry you can type this alias in any field that requires an address. This field can contain any 
characters except commas.

Key:    A secondary indexing device used for sorting and for searching. Address books can be 
sorted by key or by name.    Typically, the Name field contains the user's first and last name and 
the Key field contains the user's last name. The key field is always is displayed in uppercase. This
field cannot not contain spaces.

E-mail address:    The entry's E-mail address, specified in MHS address format. This field can 
contain up to 100 characters. Any single valid address can be entered in this field, including 
distribution lists. You may not use an alias in this field.

4. Click the OK button to save the entry and add the entry to the address book.



Deleting Address Book Entries

To delete one or more address book entries, do the following:

1. Click the Address books button on the Button Panel or select the Address books option on the 
Addresses menu. The "Select an address book" window appears. This window contains a list of 
existing address books.

2. Select the address book containing the entry you want to delete, by either highlighting the address 
book and clicking the Open button, or by double-clicking the address book in the list. The address 
book window appears.

3. Highlight the entry you want to delete and click the Delete button.

4. Click the Yes button when prompted for confirmation.



Modifying Address Book Entries

To modify an existing entry, do the following:

1. Click the Address books button on the Button Panel or select the Address books option on the 
Addresses menu. The "Select an address book" window appears. This window contains a list of 
existing address books.

2. Select the address book that you want to modify, by either highlighting the address book and 
clicking the Open button, or by double-clicking the address book in the list. The address book 
window appears.

3. Highlight the entry you want to modify and click the Edit button. The "Edit address book" entry 
window appears.

5. Make the appropriate changes.

6. Click the OK button to save the changes. 

NOTE:    If you change the name or key field in the entry, FirstMail will reindex and resort the list when 
you save your changes.



Renaming Address Books

To rename an existing address book (to the long name, the filename, or both, do the following:

1. Click the Address books button on the Button Panel or select the Address books option on the 
Addresses menu. The "Select an address book" window appears. This window contains a list of 
existing address books.

2. Highlight the address book you want to rename and click the Rename button. The "Enter long name 
and file name" dialog box appears. 

3. Make the appropriate changes. If you change the filename, you must ensure that the new filename 
contains only legal DOS characters and that the filename has no extension. Also ensure that the 
filename you specify does not already exist.

4. Click the OK button to save the changes.



Searching Address Books

The quickest way to search your address book for an address is to type the first few characters of the 
name or key you want to find. Depending on whether you sorted the address book by name or by key, 
FirstMail moves the highlight to the first name or key that matches the search string that you specify. This
process is called speed searching.

For more comprehensive searching, the Addressbook menu contains a Find command for locating (or 
selecting) entries in your address books. Select the Find option to display the "Search address book for" 
dialog box. Enter the string you want to find. If you want FirstMail to search the entire address book and 
mark all entries that match your search string, select the "Select all matching entries" check box. 
Otherwise, FirstMail highlights only the first matching entry.

To repeat the last search you made, select the Find again option from the Addressbook menu. 

The search is global, so you can search in one book, then open another address book, select the Find 
again option, and continue your search.



Customizing FirstMail

You can customize many aspects of the way FirstMail operates by selecting the Preferences option on the 
File menu. The following options are available on the Preferences menu:

General settings
NetWare MHS Settings
Signatures
Home mailbox location

These settings are stored in a file called WMAIL.PRO in your new mail directory.



General Settings

The following items can be changed in the "General settings" dialog box:

Personal name: Enter the name that FirstMail attaches to your address when you send messages. This 
name helps the recipient identify who you are. You should make this entry simple and clear. Your personal
name should contain only alphanumeric characters.

Open new mail at startup:    If selected, FirstMail automatically opens your New Mail folder when you 
open FirstMail.

Preserve deleted messages until exit:    If selected, FirstMail places any messages you delete in a special
folder called Deleted Messages, which is emptied only when you exit FirstMail. This option enables you 
to recover messages that you deleted accidentally. Enabling this option can consume disk space 
temporarily, but gives you an extra level of safety. Be careful, however, when using this setting in a low-
disk environment.

Ask for confirmation before deleting:    If selected, FirstMail prompts you for confirmation before 
deleting anything. 

Leave read new mail in new mail folder:    If selected, FirstMail leaves messages that you have opened, 
but not moved or deleted, in your New Mail folder. Normally, after you read new mail, FirstMail moves 
the message you read from the New Mail folder to your Main folder when you close the New Mail folder.

Ask for NetWare password at startup:    If selected, FirstMail prompts you for your NetWare password 
when you open FirstMail. FirstMail will not run unless you enter the password correctly.

Vertical button panel (when open):    If selected,    FirstMail changes the Button Panel from a horizontal 
layout to a vertical layout. This setting takes effect as soon as you close the "General settings" dialog box.

Offer advanced options for replies:    If selected, FirstMail displays additional options in the "Reply 
options" dialog box. The standard Reply options" dialog box contains the following options:

Copy original CC field into reply
Reply to all original addressees
Include original message in reply
"Comment-out" original message

The advanced form includes all the options. In addition, it allows you to select to which original 
addressees you want to send a reply. FirstMail checks the address fields in the original message and 
displays them with a check box. 

Selecting the Address reply to: All recipients option disables the address selection options. This 
indicates that you want to send your reply to all recipients. FirstMail copies each address.

Selecting the Address reply to: Select addresses option enables the address selection options (by 
field). This indicates that you want to selectively choose the reply recipients. FirstMail copies only 
the address(es) you select into the To field of your reply. 

When you click the OK button in the reply dialog box, FirstMail opens a standard message editor 
window. In this window, you can compose your reply. You can select the addressees in From, Reply-to, 



CC, To, and/or Sender headers (of the original message) as reply recipients.

NOTE:    If your address selections result in no addresses being selected for the message, FirstMail 
ignores your selections and attempts to use the address(es) in the Reply-to field of the original 
message. If the Reply-to field does not contain any addresses, FirstMail attempts to use the 
address(es) in the From field of the original message. 

IMPORTANT:    If the number of addresses you select exceeds the address-field limit of 180 
characters, some will be truncated. 

Save desktop state between sessions:    If selected, FirstMail retains the state of the FirstMail desktop, 
including the folders, address books, distribution lists and addressing utilities that were open at the end of 
a session, and reopens them at the start of the next session.

Folder for copies to self:    This field shows the folder you have currently designated as the folder in 
which FirstMail places copies of message you send. By default, when you select the "Copy to self" check 
box on the Message Editor window, FirstMail will place a copy of the message you send in the "Copies to
self" folder. If this folder does not exist, FirstMail creates it. When you click the Select button, the "Select
a folder" window appears. You can select a different folder, create a new one, or rename the old folder 
when it gets too full.

Default reply address:    The address that FirstMail will automatically place in the Reply-to header of the 
message you are composing. On a message-by-message basis, you can specify an address (different from 
your own) where you want replies to your message sent (for example, if you want all replies to your 
message sent to a secretary or coworker). In most instances, this field will be left blank.



NetWare MHS Settings

You can use this option to configure the way FirstMail interacts with MHS. If you are unsure of any of the
following values in this option, leave the default values as they are and consult your MHS system 
administrator for assistance. In general, you should change these options only if instructed to do so by 
your MHS system administrator.

My NetWare MHS username:    This is the username by which MHS identifies you. By default, 
FirstMail assumes that your MHS username is the same as the first eight characters of your NetWare 
username (the name you use when logging into the file server). It is possible, however, for your MHS 
username to be different from your NetWare name. Ask your MHS system administrator if you should 
enter your MHS username in this field, and if so, what address you should enter in this field. 

Mailbox name:    This is the name of the directory in the MHS tree where your new mail folder is 
located. Every MHS user has a mailbox in which messages and attachments are delivered. Usually, the 
name of this directory is the first eight characters of your username, but it can be different. If FirstMail 
warns you when it starts that it cannot find your mailbox, ask your MHS system administrator for the 
correct name and enter it in this field.

New mail folder:    This is the name of the folder in your new mail directory where FirstMail expects to 
find your new mail. This field should contain the name of your preferred messaging application. A user 
can use more than one MHS application on the same server, but normally has one which is preferred (that 
is, to which MHS delivers the messages, if no other application is specified). When a messaging 
application is installed, it is given a name, which is usually the same as the name that the developer 
registered with Novell. Ask your MHS system administrator if you need to change the name specified in 
this field.

Check the MHS New Mail folder:    When MHS creates a user, it normally defines a default preferred 
messaging application for that user, called MHS. If you set this field to Y, FirstMail checks both MHS and
FirstMail for new mail. Ask your MHS system administrator if you need to select this check box. In most 
cases, this field should be set to Y.



Signatures

A signature is text that FirstMail automatically adds to the end of messages you send. Your signature 
should contain your name, and optionally, your E-mail address, phone number, and fax number.    



Creating a Signature

A signature is text that FirstMail automatically adds to the end of messages you send. Your signature 
should contain your name, and optionally, your E-mail address, phone number, and fax number. 
Specifying a signature is optional. 

To create and edit your signature, do the following:

1. Select the Preferences option on the File menu.

2. Select the Message signature option to display the Signatures dialog box. This dialog box contains a
field for specifying your signature, and the following command buttons:

Copy:    Click this button to copy highlighted text to the clipboard.

Paste:    Click this button to paste text from the clipboard to the location of your cursor.

Help:    Click this button to display the FirstMail Help Index.

Cancel:    Click this button to cancel the current operation and close the Signatures dialog box.

Save:    Click this button to save the signature you created or modified.

3. In the Signature field, type the signature that you want added to the end of your messages. Format it 
exactly as you want it to be displayed. You can use the Copy and Paste buttons to edit the text.

4. Click the Save button.

NOTE:    To prevent FirstMail from adding your signature to the current message you are writing, select 
the No signature check box in the message editor window. 



Home Mailbox Location

Your home mailbox is a directory where FirstMail stores all your mail folders, distribution lists, address 
books, and other FirstMail related files (except unread new mail). By default, it is located in a directory 
on the file server, but you can specify an alternative location for it. You may want to change your home 
mailbox location if you have limited space on the file server.

IMPORTANT:    Before using this option, close all folder, message, distribution list, and address book 
windows (the Button Panel can be left open), or else data can be lost.

To change your home mailbox location, do the following:

1. Select the Preferences option on the File menu.

2. Select the Home mailbox location option. A warning appears, prompting you to close all windows. 
If you click the OK button, the "Home mailbox location" dialog box appears. It contains a Path field
for specifying the path to the new mailbox, a "Move contents to new location" check box, and the 
following command buttons:

Default:    Click this button to change the location of your mailbox to the default location.

Cancel:    Click this button to cancel the operation and close the "Home mailbox location" dialog 
box.

Help:    Click this button to display the FirstMail Help Index.

OK:    Click this button to accept the mailbox location you specify.

3. Enter the new path (in the Path field) in either DOS or NetWare format. 

4. To move the contents of your old mailbox to the new location, select the "Move mailbox contents to
new location" check box. 

5. If you moved your home mailbox but want to revert to the original location on the file server, click 
the Default button.

6. Click the OK button to save the changes and move your mailbox. If you selected the "Move mailbox
contents to new location" check box, FirstMail will do so now.



Filenames

When FirstMail requires you to specify a filename, the filename can contain up to eight alphanumeric 
characters (that is, A-Z, a-z, 0-9). Spaces and special characters are not allowed. The filename cannot 
contain an extension.

To specify the full path to another directory, you can use either DOS path syntax or full NetWare syntax.



Address Format

When specifying a recipient address, you must use MHS address format (user@workgroup). Separate 
multiple addresses with commas. For specific questions about addressing, check with your MHS 
administrator.



Selecting Multiple Items from a List

To highlight multiple items in a list (such as messages, folders, addresses), hold down the <Ctrl> key and 
click each item. To select a range of messages or addresses from a list, hold down the <Shift> key and 
drag the mouse down the list.

Highlighting multiple items enables you to perform an operation on multiple items at the same time.



Wildcard Characters

A wildcard character is a character that represents a single or group of characters. The question mark (?) 
character matches any single character (for example, "?illy" matches both "Willy" and "Billy"). The 
asterisk (*) character matches any number of characters (for example, "j*on" matches "johnson", 
"jefferson" and "Jerry Harmon").



Message Headers

Message headers are a set of special lines at the start of a message. The headers contain addressing and 
other information about the message. Headers are rigidly formatted.



CC (Carbon Copy) Recipients 

A CC (carbon copy) recipient is an addressee you specify in the CC field. Each Carbon Copy recipients 
receives a copy of the message you send to a primary recipient (that is, the recipient you specify in the To 
header). 



Blind CC (Blind Carbon Copy) Recipients

A Blind CC (Blind Carbon Copy) recipient is an addressee you specify in the Blind CC field. Any 
recipient specified in this field will receive a copy of the message you send to a primary recipient (that is, 
the recipient you specify in the To header). Use the Blind CC field to specify a recipient when you want to
send a copy of your message to someone without any other recipient knowing you have done so. 



Primary Recipients

The To header of a message contains the address(es) of the primary recipient(s) of a message.



Folders

A folder is a file in which messages are stored. 

The Main folder is the default mail file containing messages that you previously read.    FirstMail moves 
your messages into the Main folder after you read them. 

You can also create other folders to organize messages that you wish to keep.

NOTE:    The only "folder" that is not a mail file is the New Mail folder. The New Mail "folder" is 
actually a directory to which your new messages are delivered. 



Aliases

An alias is a name that represents a recipient's E-mail address. You can associate a recipient's name with 
that recipient's E-mail address in an address book. After doing so, you can specify either the alias or the 
E-mail address when addressing a message to that recipient. If you use the alias, FirstMail looks up the E-
mail address before sending the message. 

For example, if Jane Jones's E-mail address is jjones@sales.acme, you could associate the alias Jane with 
her E-mail address and then address messages to Jane whenever you send her E-mail. 



Key

A key is a secondary indexing device used for sorting and for searching. Address books can be sorted by 
key or by name. Typically, the Name field contains the user's first and last name and the Key field 
contains the user's last name. A key cannot contain spaces.




